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Personal Profile

I am a Professor of Pharmaceutical Chemistry and currently Head of the Department of Pharmaceutical
Chemistry at the Kwame Nkrumah University of Science and Technology (KNUST), Kumasi. I have
extensive experience in teaching, research management, institutional leadership, and international
academic collaboration. I previously served three terms as Head of the Department of Pharmaceutical
Chemistry (2014-2017) and Head of the Department of Herbal Medicine (2020-2022). I am a Fellow of
the Ghana College of Pharmacists and the immediate past Chairman of the Academic, Social and
Research Pharmacists Association (ASRPA). I served on the Governing Board of the Pharmaceutical
Society of Ghana (2019-2023) and currently serve on the Governing Board of the Traditional Medicine
Practice Council. My research interests include pharmacokinetics, bioavailability, stability evaluation of
allopathic and plant medicines, pharmaceutical analysis, drug regulation, quality control, and novel drug
formulation development. I have published extensively in peer-reviewed international journals and
presented at numerous conferences, and I serve as a reviewer for several international journals. Since
returning to Ghana after my PhD, I have contributed to bridging the academia-industry gap and
strengthened the professional training for PharmD and allied health programmes. I have supervised seven
(7) PhD graduates since 2019 who are now academics and professionals globally. I also serve as a
Visiting Professor at Madonna University Nigeria and China Pharmaceutical University,(Nanjing, China).

PERSONAL INFORMATION

Date of Birth: 23rd July 1973, Cape Coast
Nationality: Ghanaian

Marital Status: Married with 4 Children

Next of Kin: Mrs. Olivia Ayensu

Hobbies: Composing songs, Singing, Playing of
Guitar and Drums

Contact Address:
Department of Pharmaceutical Chemistry
Faculty of Pharmacy and Pharmaceutical Sciences
College of Health Sciences
Kumasi, Ghana
Tel: +233 50 660 1517 / +233 55 313 9489
Email: iayensu.pharm@knust.edu.gh |
ORCID ID: 0000-0002-0904-7708 yensua@yahoo.com
Scopus Author ID: 54405559700
Google Scholar: Citations: 1,152 | h-index: 16 | 110-
Social Media: linkedIn: Isaac Ayensu | Twitter: index: 20
@Ayensu- Isaac07 ResearchGate: Score: 601.2

EDUCATION

Fellow, Ghana College of Pharmacist Accra, Ghana
(Fellow), August, 2025
University of Greenwich UK
Doctor of Philosophy (PhD),2013), Commonwealth Scholarship 2009-2013
Kwame Nkrumah University of Science and Technology (KNUST) Kumasi, Ghana
Commonwealth Executive Masters in Public Administration (CEMPA),2015), 2013-2015
Kwame Nkrumah University of Science and Technology (KNUST) Kumasi, Ghana
MSc. Pharm. Analysis and Quality Control,2003), 2000-2002
University of Science and Technology (UST) Kumasi, Ghana
B. Pharm (First Class Hons), 1999), 1994-1999
Mfantsipim School Cape Coast, Ghana
GCE O'"and A' Levels 1991 and 1993 respectively.), 1988 - 1993
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WORK EXPERIENCE
UNIVERSITY TEACHING AND RESEARCH EXPERIENCE

Professor | Department of Pharmaceutical Chemistry, KNUST, Ghana 2023 - Date
Associate Professor | Department of Pharmaceutical Chemistry, KNUST, Ghana 2019 - 2023
Senior Lecturer | Department of Pharmaceutical Chemistry, KNUST, Ghana 2013 -2019
Lecturer | Department of Pharmaceutical Chemistry, KNUST, Ghana 2003 - 2013
Teaching Assistant | Department of Pharmaceutical Chemistry, Faculty of Pharmacy, KNUST 2002
Demonstrator | Department of Pharmaceutical Chemistry, Faculty of Pharmacy, KNUST 2000

Visiting Academic Appointments

Visiting Professor | China Pharmaceutical University, Nanjing, China 2021 to Date
* Invited Lecturer (2021-2025)
* Research collaboration and exchange

Visiting Professor | Madonna University, Nigeria June 2016 to Date
* Regular visiting lectureship and research collaboration

Assistant Lecturer/Academic Support | University of Greenwich School of Science, UK 2010 - 2012
* Provided academic support and assistance in teaching during PhD studies

Part-Time Lecturer | Dispensing Technology Department, Kumasi Polytechnic 2003 - 2005

* Lectured in Dispensing Technology

Research Areas/Expertise

Research Areas
1. Medicinal plants isolation and characterization.

2. Pharmaceutical analysis, characterization and quality control.

3. Pharmaceutical and heavy metal contaminants in the environment.

4. Novel drug formulation and development.

5. Medicinal Chemistry.

6. Novel Application of hydrotropic Solubilization technique in drug analysis.

7. Cosmetological studies.

CURRENT AND RECENT RESEARCH PROJECTS
On-going Projects 2025
1. Ghanaian Cannabis: Classification of major Phyto-cannabinoids and the link between elemental

content and geographic location

2. Towards Harnessing the full Therapeutic Potential of Xylopic Acid: Studies on selected topical gray
areas

3. Phthalates in Pharmaceuticals: A case of locally manufactured liquid Pharmaceuticals in the Ashanti
Region of Ghana

4. Evaluation of the Anticancer, Antioxidant and Phytochemical Constituents of Adansonia Digitata L.
(Malvaceae)

5. Exploratory Bioavailability studies on Herbal products
6. Development and Validation of Stability indicating HPLC Method for selected Herbal Pharmaceuticals
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7. Filtration systems for water bodies contaminated by heavy metals from mining activities and
pharmaceutical residues

8. Development and Validation of Stability indicating HPLC Method for the Simultaneous Estimation of
Selected Analgesics

9. Anti-Infective Extracts and Phytoconstituents Isolated from Zea Mays and other Ghanaian Medicinal
Plants

10. Synthesis of 'clicked' compounds and their phosphonium salts as targets against some tropical
infections

11. Isolation, characterization and microbial assay of a biomarker (Bergenin) and development of RP-
HPLC method for the quality control of the roots of securinega virosa

12. Detection and quantification of aphrodisiac adulterants in alcoholic beverages in Ghana

13. Qualitation and Quantification of Tryptophan in Hausa Koko (Spicy Millet Porridge): A Ghanaian
Beverage

14. Novel Application of hydrotropic Solubilization technique in the formulation and analysis of poorly
soluble drugs

15. Phytochemical Screening, Antimicrobial, Antioxidant and Anti-inflammatory activities of various
extracts of the leaves and stem bark of Allanblackia parviflora (A Chevalier)

16. Comparative quantitative and activity analysis of antibiotics. Case study of NHIS and non-NHIS
medicines

17. Determination of levels of lead in popularly patronised cosmetic products

18. Antimicrobial activities and phytochemical screening of the stem bark of Trichilia tessemannii
(Harms) of the family Meliaceae

19. Development characterisation of laminated thiolated chitosan-based lyophilised xerogels for potential
buccal delivery of macromolecules

20. Effect of protease enzyme inhibitors on mucoadhesion and release kinetics of macromolecules from
laminated thiolated-chitosan freeze-dried xerogels

RECENT PUBLICATIONS IN PEER REVIEWED JOURNALS

1. Khongorzul, P., Mainza, N., Tiiba, . J. deen, Ibrahim, T. S., Goku, F., Ayensu, 1., & Alolga, R. N. (2026).
Role of gut microbiota in the anti-rheumatoid arthritis activity of xylopic acid. Natural Product Research,
1-11. https://doi.org/10.1080/14786419.2026.2647368

2. Alolga, R. N., Adobagna, L. A., Ayensu, 1., Changqing, L., Goku, F., Ibrahim, T. S., & Mainza, N. (2025).
A proteomics-metabolomics approach and mineral content analysis reveal inherent differences in the
quality of Bambara groundnuts from two geographic regions. Journal of the Science of Food and
Agriculture, 105 (2), 1001-1011.

3. Alolga, R. N., Ayensu, 1., Boakye, P., Adobagna, L. A., Ofori, E. G., & Mainza, N. (2025). Low-
temperature heat capacity and other thermodynamic characteristics of xylopic acid crystals. Chemistry
Africa. Advance online publication.

4. Turkson, B. K., Nketia, R. I., Frimpong, C. K., Mensah, K. S., Sarfo, A. S., Safo, O. N., Bekoe, B. O.,
Ayensu, I., Mensah, M. L. K., & Zoiku, F. (2024). Antiplasmodial activity and toxicity of the leaves, stem
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and roots of Parinari robusta Oliv [CHRYSOBALANACEAE] in animal model. South African Journal
of Botany, 168, 71-76.

5. Tordzagla, N., Ayensu, 1., & Oppong-Kyekyeku, J. (2024). Phytochemical constituents from corn silk and
antimicrobial activity of the isolates. International Journal of Secondary Metabolite, 11 (4), 604-622.
https://doi.org/10.21448/ijsm.1302694

6. Brobbey, A., Adu-Brimpong, B., Addotey, J. N., Asare-Nkansah, S., Ayensu, 1., Appiah, E., & Derizie, A.
(2023). Cafteine content in energy drinks can be determined using a validated liquid-liquid extraction
method coupled to UV-visible spectrophotometry. Nutrition & Food Science International Journal, 12
(2), Article 555834. https://doi.org/10.19080/NFS1J.2023.12.555834

7. Alolga, R. N., Ayensu, 1., & Sosu, J. S. (2023). Forced degradation studies, elucidation of degradation
pathways and degradation kinetics of xylopic acid via LC and LC-MS/MS analyses. Journal of
Pharmaceutical Sciences, 112 (8), 2029-2036.

8. Alolga, R. A., Wang, S., Ayensu, L., & Nebeolisa, C. S. (2022). Pharmacokinetics and in vitro liver
microsomal enzyme metabolism of xylopic acid. Journal of Pharmaceutical and Biomedical Analysis,
224, Article 115200.

9. Douvris, C., Bentil, E., Ayensu, I., Osei Akoto, C., Amponsah, 1. K., Adu, J., & Bussan, D. (2022). Trace
metals in cannabis seized by law enforcement in Ghana and multivariate analysis to distinguish among
different cannabis farms. Toxics, 10 (10), Article 567.

10. Amengor, C. D. K., Brobbey, A., Ayensu, I., Orman, E., Peprah, P., Abudey, B. M., Ayibi, S. J., Attoh, C.
N. D., Ade, A., Sodzi, P. K., & Aboagye, J. S. (2022). Acid-base indicator properties of synthesized
phenylhydrazones. Journal of Chemistry, 2022, Article 3667814.

11. Tordzagla, N., Ayensu, 1., & Ofori, M. F. (2022). In vivo and in vitro antiplasmodial activity of extracts,
fractions and an isolated compound from silk of Zea mays (corn silk). Journal of Medical
Pharmaceutical and Allied Sciences, 11 (3), 4810-4816.

12. Mensah, J. N., Brobbey, A. A., Addotey, J. N., Ayensu, I., Asare-Nkansah, S., Opuni, K. F. M., &
Adutwum, L. A. (2021). Ultraviolet-visible spectroscopy and chemometric strategy enable the
classification and detection of expired antimalarial herbal medicinal product in Ghana. International
Journal of Analytical Chemistry, 2021, Article 5592217.

13. Quartey, A. K., Ayensu, ., Orman, E., Mireku-Gyimah, N. A., Jibira, Y., & Goku, P. E. (2021). In-vivo
anti-inflammatory activity of different parts of Adansonia digitata. Journal of Medicinal Plants Research,
15 (6), 252-259.

14. Ade, A., Amengor, C. D. K., Brobbey, A., Ayensu, ., Harley, B. K., & Boakye, Y. D. (2020). Synthesis
and antimicrobial resistant modulatory activity of 2,4-dinitrophenylhydrazone derivatives as agents
against some ESKAPE human pathogens. Journal of Chemistry, 2020, Article 2720697.

15. Quartey, A. K., Jibira, Y., Forkuo-Donkor, A., Ayensu, 1., Oduro-Kwarteng, A. A., Asuamah, S. E., &
Noah, P. (2020). Hydroethanolic stem bark extract of Vernonia amygdalina Del. (Asteraceae) suppresses
yeast induced pyrexia and Plasmodium berghei malaria in murine models. Journal of Medicinal Plants
Research, 14 (6), 258-264.
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16. Ayensu, 1., Bekoe, S. O., Adu, J. K., Brobbey, A. A., & Appiah, E. (2020). Evaluation of acid neutralising
and buffering capacities of selected antacids in Ghana. Scientific African, 10, Article e00589.

17. Amenu, J. D., Ayensu, 1., Bekoe, S. O., & Yamoah, A. (2019). Characterization and RP-HPLC method
development of a biomarker (bergenin) from the roots of Securinega virosa. Journal of Basic and Applied
Research International, 25 (6), 358-367.

18. Danson, D., Ehoneah, O., Ayensu, 1., Brobbey, A. A., Adu, J. K., & Bekoe, S. O. (2019). Determination
of tryptophan content in Hausa Koko (spicy millet porridge): A Ghanaian beverage. International Journal
of Phytopharmacy, 9 (4), Article e5287.

19. Adu, J. K., Dzakadzie, F., Orman, E., Ayensu, 1., Amengor, C. D. K., & Kwofie, S. (2019). Assessing
metal contaminants in milled maize products available on the Ghanaian market with atomic absorption
spectrometry and instrumental neutron activation analyser techniques. Food Control, 109, Article 106932.

20. Yir-Erong, B., Bayor, M. T., Ayensu, 1., Gbedema, S. Y., & Boateng, J. S. (2019). Oral thin films as a
remedy for noncompliance in pediatric and geriatric patients. Therapeutic Delivery, 10 (7), 443-464.

21. Yir-Erong, B., Bayor, M. T., Ayensu, L., Gbedema, S. Y., & Boateng, J. (2018). The challenges and
knowledge gaps in malaria therapy: A stakeholder approach to improving oral quinine use in the
treatment of childhood malaria in Ghana. Journal of Pharmaceutics, 2018, Article 1784645.

22. Opoku, S., Ayensu, L., Brobbey, A. A., & Adjavon, K. A. (2018). Metronidazole analysis: Method
development and validation via hydrotropic solubilization. International Journal of Pharmacy and
Pharmaceutical Research, 12 (4), 1-13.

23. Tordzagla, N., Adosraku, R. K., Ayensu, L., Aseidu-Larbi, J., Ocloo, A., Ofori, M. F., & Antwi, S. (2018).
In vivo antiplasmodial activity of extracts of selected Ghanaian medicinal plants. Investigational
Medicinal Chemistry and Pharmacology, 1 (2), Article 12.

24. Ayensu, 1., Adu, J. K., & Boateng, J. S. (2017). Stability evaluation of protein drugs in optimised
thiolated-chitosan based buccal xerogels. Journal of Science and Technology, 37 (3), 46-53.

25. Mintah, D. N., Quartey, A. K., Oppong, A. B., Ayensu, 1., & Apenteng, J. A. (2017). Synergistic in-vitro
anthelmintic potentials of Vernonia amygdalina Delile stem and Carica papaya Lin. seeds. World Journal
of Pharmacy and Pharmaceutical Sciences, 6 (10), 103-115.

26. Brobbey, A. A., Somuah-Asante, S., Asare-Nkansah, S., Osei, B. F., & Ayensu, 1. (2017). Preliminary
phytochemical screening and scientific validation of the anti-diabetic effect of the dried husk of Zea mays
L. (corn, Poaceae). International Journal of Phytopharmacy, 7 (1), 1-5.

27. Adu, J. K., Amoah, E., Ayensu, 1., Osei-Djarbeng, S., & Jagri, P. (2016). Phytochemical screening and
antimicrobial activities of the stem bark of Allanblackia parviflora Chev (Clusiaceae). The Journal of
Phytopharmacology, 5 (6), 215-224.

28. Ayensu, L., Doe, E., Brobbey, A. A., & Adosraku, R. (2016). Assessment of bioequivalence profile of
locally produced flucloxacillin sodium capsules via urinary excretory rates. Journal of Science and
Innovative Research, 5 (4), 125-129.
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29. Ayensu, I., & Quartey, A. K. (2015). Phytochemical screening and in-vitro antioxidant properties of the
stem bark of Trichilia tessemannii (Hams) (Meliaceae). World Journal of Pharmacy and Pharmaceutical
Sciences, 4 (3), 76-90.

30. Brobbey, A. A., Quartey, A. K., Otuo-Serebour, S., & Ayensu, 1. (2015). Determination of the
phytochemical constituents, antimicrobial and antitussive activities of the leaves of Solanum torvum
(Swartz). World Journal of Pharmacy and Pharmaceutical Sciences, 5 (1), 1363-1375.

31. Ayensu, L., & Quartey, A. K. (2015). Antimicrobial activities of the stem bark of Trichilia tessemannii
(Hams) and Trichilia monadelpha (Thonn) J.J. de Wilde both of the family Meliaceae. World Journal of
Pharmacy and Pharmaceutical Sciences, 4 (9), 1351-1362.

32. Ofori-Kwakye, K., Ayensu, 1., Akyina, B., Kipo, S. L., & Boakye-Gyasi, M. E. (2014). Adulteration of
Ghanaian topical herbal preparation with dexamethasone. World Journal of Pharmacy and
Pharmaceutical Science, 3 (6), 134-141.

33. Boateng, J. S., Mitchell, J. C., Pawar, H., & Ayensu, 1. (2014). Functional characterisation and permeation
studies of lyophilised thiolated chitosan xerogels for buccal delivery of insulin. Peptide and Protein
Letters, 21 (11), 1163-1175.

34. Pawar, H., Boateng, J. S., Ayensu, 1., & Tetteh, J. (2014). Multifunctional medicated lyophilised wafer
dressing for effective chronic wound healing. Journal of Pharmaceutical Sciences, 103 (6), 1720-1733.

35. Boateng, J., & Ayensu, 1. (2014). Preparation and characterisation of laminated thiolated chitosan-based
freeze-dried wafers for potential buccal delivery of macromolecules. Drug Development and Industrial
Pharmacy, 40 (5), 611-618.

36. Giovino, C., Ayensu, L., Tetteh, J., & Boateng, J. (2013). An integrated buccal delivery system combining
chitosan films impregnated with peptide loaded PEG-b-PLA nanoparticles. Colloids and Surfaces B:
Biointerfaces, 112, 9-15.

37. Kianfar, F., Ayensu, L., & Boateng, J. (2013). Development and physico-mechanical characterization of
carrageenan and poloxamer based lyophilized polymeric matrix as a potential buccal drug delivery
system. Drug Development and Industrial Pharmacy, 40 (3), 361-369.

38. Ayensu, 1., & Boateng, J. S. (2012). Development and evaluation of lyophilized thiolated-chitosan wafers
for buccal delivery of protein. Journal of Science and Technology, 32 (2), 46-55.

39. Ayensu, 1., Mitchell, J. C., & Boateng, J. S. (2012). Effect of membrane dialysis on characteristics of
lyophilised chitosan wafers for potential buccal delivery of proteins. International Journal of Biological
Macromolecules, 50, 905-909.

40. Ayensu, 1., Mitchell, J. C., & Boateng, J. S. (2012). In vitro characterisation of chitosan based xerogels for
potential buccal delivery of proteins. Carbohydrate Polymers, 89, 935-941.

41. Giovino, C., Ayensu, 1., Tetteh, J., & Boateng, J. S. (2012). Development and characterisation of chitosan
films impregnated with insulin loaded PEG- -PLA nanoparticles (NPs): A potential approach for buccal
delivery of macromolecules. International Journal of Pharmaceutics, 428, 143-151.
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42. Ayensu, ., Mitchell, J. C., & Boateng, J. S. (2011). Development and physico-mechanical
characterisation of lyophilised chitosan wafers as potential protein drug delivery systems via the buccal
mucosa. Colloids and Surfaces B: Biointerfaces, 91, 258-265.

43. Ayensu, I., Mitchell, J. C., & Boateng, J. S. (2011). Formulation and evaluation of lyophilised thiolated
chitosan wafers for buccal mucosal delivery of proteins. The AAPS Journal, 13 (Suppl. 2), M1144.

44. Ayensu, 1., Mitchell, J. C., & Boateng, J. S. (2010). Freeze-dried thiolated chitosan formulations for
protein delivery via the buccal mucosa. Journal of Pharmacy and Pharmacology, 62 (10), 1273-1274.

45. Ayensu, 1., Mitchell, J. C., & Boateng, J. S. (2010). Novel lyophilisation cycle development of chitosan-
based formulations for buccal delivery using paracetamol as model drug. The AAPS Journal, 12 (Suppl.
2), W4170.

46. Ayensu, I., & Okine, N. N. A. (2008). Determination of relative bioavailability of paracetamol tablets
using urinary excretory data. The Ghana Pharmaceutical Journal, 33 (2), 9-18.

Book Chapter 2014

* Boateng J, Ayensu I, Pawar H. (2014). Chitosan in: Khutoryanskiy (Editor). Mucoadhesive Materials and
Drug Delivery Systems John Wiley and Sons Ltd, West Sussex, United Kingdom. ISBN 9781119941439.
235-254.

Published Thesis 1999 - 2015

* Ayensu I. (2015). Evaluating the Performance of the Collegiate System at KNUST.-MSc. Thesis submitted
to KNUST.

* Ayensu 1. (2012). Development of novel formulations for mucosal delivery of protein-based drugs. - PhD
Thesis, submitted to the University of Greenwich, (UK). Commonwealth Scholarship Grant.

* Ayensu 1. (2002). Determination of Bio-availability of a locally manufactured Paracetamol Tablets Using
Urinary Excretory Data.

- MSc. Thesis submitted to KNUST.
* Ayensu 1. (1999). Assay of Morphine hydrochloride ampoules. - B.Pharm Thesis submitted to UST.
Conference Proceedings 2010 - 2021

1. Turkson, B. K., Mensah, M. L. K., Ayensu, 1., & Amponsah, 1. K. (2021). Toward collaboration to
improve the integration of traditional and orthodox medicine for holistic healthcare delivery in Ghana.
9th Biennial Scientific Conference of the College of Health Sciences, KNUST. (Poster No. 44).

2. Ayensu, ., Bekoe, S. O., Adu, J. K., Brobbey, A. A., & Appiah, E. (2019). Evaluation of acid neutralizing
and buffering capacity of selected antacids in Ghana. Annual General Meeting of the Pharmaceutical
Society of Ghana. Accra, Ghana.
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3. Ade, A., Brobbey, A. A., Ayensu, L., Amengor, C., & Adu, J. K. (2019). Synthesis and antimicrobial
activities of 2,4-dinitrophenylhydrazone derivatives. Pharmacy Graduate Students' Week. (Poster No.
PP004). Kwame Nkrumah University of Science and Technology, Kumasi, Ghana.

4. Quartey, A. K., & Ayensu, . (2019). Anti-inflammatory properties of various parts of Adansonia digitata
(Malvaceae). Pharmacy Graduate Students' Week. (Poster No. PP005). Kwame Nkrumah University of
Science and Technology, Kumasi, Ghana.

5. Danson, D., Ehoneah, O., Ayensu, 1., Brobbey, A. A., Adu, J. K., & Bekoe, S. O. (2019). Qualitation and
quantification of tryptophan in Hausa Koko (spicy millet porridge): A Ghanaian beverage. Pharmacy
Graduate Students' Week. (Poster No. PP019). Kwame Nkrumah University of Science and Technology,
Kumasi, Ghana.

6. Amenu, J. D., Ayensu, 1., Bekoe, S. O., & Ahimsa, Y. (2019). Characterization and RP-HPLC method
development of a biomarker (bergenin) from the roots of Securinega virosa. Pharmacy Graduate
Students' Week. (Poster No. PP021). Kwame Nkrumah University of Science and Technology, Kumasi,
Ghana.

7. Safrega, B., & Ayensu, 1. (2019). Development and validation of stability indicating HPLC method for
simultaneous estimation of paracetamol, ibuprofen and caffeine in drug formulation. Pharmacy Graduate
Students' Week. (Poster No. PP038). Kwame Nkrumah University of Science and Technology, Kumasi,
Ghana.

8. Ayensu, I., Agyeman, S., Appiah, E., & Jackson, E. (2017). Hydrotropic solubilization method for the
analysis of furosemide in pure powders and formulated tablets. BSU II Conference. (Poster No. H7).
Kumasi, Ghana.

9. Buabeng, K. O., Ayensu, 1., Mensah, K. B., Owusu-Ofori, A., Bekoe, S. O., Boakye-Gyasi, E., Anto, B. P.,
Mantey, P., & Adu, O. A. (2017). Assessing water quality in the Asante Akim Districts in Ghana. BSU I
Conference. (Poster No. H2). Kumasi, Ghana.

10. Ayensu, 1., Amoah, E., Adjavon, K. A., Osei-Djarbeng, S., & Adjei, E. (2017). Anti-oxidant activities of
the stem bark of Allanblackia parviflora Chev. (Clusiaceae). BSU II Conference. (Poster No. C21).
Kumasi, Ghana.

11. Ayensu, L., & Quartey, A. K. (2015). Phytochemical, antimicrobial and antioxidant constituents of
Trichilia monadelpha (Thonn) J.J. de Wilde and Trichilia tessemannii (Harms) both of the family
Meliaceae. Postgraduate Day, Faculty of Pharmacy and Pharmaceutical Sciences, KNUST. (Poster No.
31). Kwame Nkrumah University of Science and Technology, Kumasi, Ghana.

12. Quartey, A. K., & Ayensu, I. (2014). Antimicrobial activities of the stem bark of Trichilia monadelpha
(Thonn) J.J. de Wilde of the family Meliaceae. 7th Annual Research Conference, Graduate Students
Association of Ghana, KNUST. (Poster No. 7). Kwame Nkrumah University of Science and Technology,
Kumasi, Ghana.

13. Quartey, A. K., & Ayensu, 1. (2014). Antimicrobial activities of the stem bark of Trichilia tessemannii
(Harms) of the family Meliaceae. Workshop on Medicinal Plant Research. (Poster No. 1). Noguchi
Memorial Institute for Medical Research and SATRPS (JICA/JST), Accra, Ghana.
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14. Pawar, H., Ayensu, 1., Tetteh, J., & Boateng, J. (2013). Sodium alginate based antimicrobial wound
dressings for chronic wound healing. /st Hydrocolloids Symposium. University of Huddersfield,
Huddersfield, United Kingdom.

15. Ayensu, 1., Mitchell, J. C., & Boateng, J. S. (2012). Development of laminated chitosan based lyophilized
xerogels for potential buccal delivery of macromolecules. UKPharmSci 2012. (Abstract No. 42).
Nottingham, United Kingdom.

16. Ayensu, 1., Mitchell, J. C., & Boateng, J. S. (2012). In-vitro permeation studies of insulin using lamb
buccal tissue and Epi-oral TM buccal tissue construct. UKPharmSci 2012. (Abstract No. 60). Nottingham,
United Kingdom.

17. Ayensu, 1., Mitchell, J. C., & Boateng, J. S. (2012). Evaluation of enzyme inhibitors on laminated
thiolated chitosan xerogels for buccal delivery of insulin. 2012 AAPS Annual Meeting and Exposition.
(Abstract .D. AM-12-01660). Chicago, IL, United States.

18. Ayensu, 1. (2012). Development of novel formulations for mucosal delivery of protein-based drugs
[Research presentation]. University of Greenwich, London, United Kingdom.

19. Ayensu, 1., Mitchell, J. C., & Boateng, J. S. (2011). Development and characterisation of lyophilised
chitosan wafers: Effect of membrane dialysis. UKPharmSci 2011. (Abstract No. 59). Nottingham, United
Kingdom.

20. Ayensu, 1., Mitchell, J. C., & Boateng, J. S. (2011). Formulation and evaluation of lyophilised thiolated
wafers for buccal mucosa delivery of proteins. The AAPS Journal, 13 (Suppl. 2).

21. Ayensu, 1., Mitchell, J. C., & Boateng, J. S. (2011). Characterisation and evaluation of lyophilised
chitosan (CS) wafers for protein delivery via the buccal mucosa. UKPharmSci 2011. (Abstract No. 43).
Nottingham, United Kingdom.

22. Ayensu, L., Mitchell, J. C., & Boateng, J. S. (2010). Freeze dried thiolated chitosan formulations for
protein delivery via the buccal mucosa. UKPharmSci 2010. (Abstract No. 42). Nottingham, United
Kingdom.

23. Ayensu, L., Mitchell, J. C., & Boateng, J. S. (2010). Freeze dried thiolated chitosan formulations for
protein delivery via the buccal mucosa. School of Science, University of Greenwich at Medway,
Chatham Maritime, United Kingdom.

24. Ayensu, 1., Mitchell, J. C., & Boateng, J. S. (2010). Novel lyophilization cycle development of chitosan-
based formulation for buccal delivery using paracetamol as a model drug. A4PS PharmSciTech, 11
(Suppl. 2), W4170.

Podium Presentations 2004 - 2024

25. Adu, O. A., Brobbey, A. A., & Ayensu, 1. (2024, June 5). Phthalates in pharmaceuticals: A case of locally
manufactured liquid pharmaceuticals in the Ashanti Region of Ghana [Conference presentation]. 2nd
Annual College of Health Sciences Postgraduate Conference, Kwame Nkrumah University of Science
and Technology, Kumasi, Ghana.
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26. Alolga, R. N., Oppong-Kyekyeku, J., Adosraku, R. K., & Ayensu, 1. (2024, June 5). Towards harnessing
the full therapeutic potential of xylopic acid: Studies on selected gray areas [Conference presentation].
2nd Annual College of Health Sciences Postgraduate Conference, Kwame Nkrumah University of
Science and Technology, Kumasi, Ghana.

27. Quartey, A. K., & Ayensu, L. (2021). Toxicity and in-vivo anti-inflammatory activity of different parts of
Adansonia digitata [Conference presentation]. 9th Biennial Scientific Conference of the College of Health
Sciences, KNUST. (Oral Presentation 15). Kwame Nkrumah University of Science and Technology,
Kumasi, Ghana.

28. Agbetiameh, B. K., Essel, E., & Ayensu, 1. (2020, November 19). Public health risks and content
evaluation of hydroquinone containing creams [Conference presentation]. COBREG 2020 Virtual
Conference.

29. Ayensu, 1., Bekoe, S. O., Adu, J. K., Brobbey, A. A., & Appiah, E. (2019). Evaluation of acid neutralizing
and buffering capacity of selected antacids in Ghana [Conference presentation]. Annual General Meeting
of the Pharmaceutical Society of Ghana, Accra, Ghana.

30. Tordzagla, N., Adosraku, R. K., Ayensu, 1., Asiedu-Larbi, J., Ocloo, A., Fokuo, O. M., & Antwi, S. (2019).
In-vivo antiplasmodial activity of extracts of selected Ghanaian medicinal plants [Conference
presentation]|. Pharmacy Graduate Students' Week. (OP013). Kwame Nkrumah University of Science and
Technology, Kumasi, Ghana.

31. Bekoe, S. O., Ayensu, 1., Buabeng, K. O., Boakye-Gyasi, E., Mensah, K. B., & Adu, A. O. (2017).
Detection of pharmaceutical contaminants in water sources in two peri-urban communities in Ghana
[Conference presentation]. BSU II Research Conference, Kumasi, Ghana.

32. Ayensu, 1., Agyeman, S., & Aryee, K. A. (2017). Development and validation of novel method of analysis
of metronidazole via hydrotropic solubilization [Conference presentation]. BSU II Research Conference,
Kumasi, Ghana.

33. Quartey, A. K., & Ayensu, . (2014, August). Phytochemical, antimicrobial and antioxidant constituents of
Trichilia monadelpha (Thonn) J.J. de Wilde and Trichilia tessemannii (Harms) both of the family
Meliaceae [Conference presentation]. Annual General Meeting of the Pharmaceutical Society of Ghana,
Ghana.

34. Ayensu, 1., Mitchell, J. C., & Boateng, J. S. (2012). Development of laminated chitosan based lyophilized
xerogels for potential buccal delivery of macromolecules [Conference presentation]. UKPharmSci 2012,
Nottingham, United Kingdom.

35. Ayensu, 1., Mitchell, J. C., & Boateng, J. S. (2011). Characterisation and evaluation of lyophilized
chitosan wafers for protein delivery via the buccal mucosa [Conference presentation]. UKPharmSci 2011,
Nottingham, United Kingdom.

36. Ayensu, 1., Banning, K., & Debrah, P. (2008). Promoting "NEW-START" (Nutrition, Exercise, Water,
Sunlight, Temperance, Air, Rest and Trust in God) approach towards regenerative health [Conference
presentation]. Annual General Meeting of the Pharmaceutical Society of Ghana, Ghana.
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37. Okine, N. N. A., Adosraku, R., Ayensu, ., & Baidoo, S. P. (2006). Bioavailability assessment of some
locally manufactured chloroquine phosphate tablets [Conference presentation]. Annual General Meeting
of the Pharmaceutical Society of Ghana, Ghana.

38. Okine, N. N. A., & Ayensu, 1. (2004). Bio-availability studies on locally manufactured paracetamol
tablets using urine samples [Conference presentation]. Annual General Meeting of the Pharmaceutical
Society of Ghana, Ghana.

SUPERVISION OF STUDENT PROJECT WORK/THESIS/RESEARCH

Supervision Summary

I have supervised to completion 7 PhD students, 25 MPhil students and 92 undergraduate student
projects since [ was appointed a lecturer. I am currently supervising 4 PhD students, 2 MPhil students
and 7 undergraduate students.

PhD SUPERVISION (Completed)

1. Bentil Edward | PhD, Pharmaceutical Chemistry March 2025
* Ghanaian Cannabis: Classification of major Phyto-cannabinoids and the link between elemental content

and geographic location
» Status: Completed

2. Raphael Alolga | PhD, Pharmaceutical Chemistry Nov. 2024
» Towards harnessing the full therapeutic potential of xylopic acid: Studies on selected gray areas
» Status: Completed

3. Adu Owusuaa Abena | PhD, Pharmaceutical Chemistry Nov. 2024
* Phthalates in Pharmaceuticals: A case of locally manufactured liquid Pharmaceuticals in the Ashanti

Region of Ghana
» Status: Completed

4. Okey Edith Nwakaego | PhD, Civil Engineering (Co-Supervisor) April 2023

 Environmental pollution of water bodies by pharmaceutical residues
» Status: Completed

5. Quartey A.K. | PhD, Pharmaceutical Chemistry Jan. 2023
* Characterisation of some Bioactive Compounds from Adansonia digitata I. (malvaceae)
* Status: Completed

6. Tordzagla N. | PhD, Pharmaceutical Chemistry Nov. 2019
* Anti-Infective Extracts and Phytoconstituents Isolated from Zea Mays and other Ghanaian Medicinal

Plants
» Status: Completed

7. Amengor C.D.K. | PhD, Pharmaceutical Chemistry Feb. 2019
* Synthesis of 'clicked' compounds and their phosphonium salts as targets against some tropical infections
» Status: Completed

MPHIL SUPERVISION (Main Supervisor, Dept. Pharmaceutical Chemistry)

1. Bediako Winfred Ashie | MPhil, Pharmaceutical Chemistry 2026
* Unravelling the enzyme-like activity of custom-designed nanozymes for application in the development of
diagnostic assays
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* Status: Completed
2. Evans Kwesi Amankwah | MPhil, Pharmaceutical Chemistry

* Development and validation of analytical methods and sampling methodology for trace level of
paracetamol, caffeine, and aspirin in support of cleaning validation

» Status: Completed
3. Noble Awuah | MPhil, Pharmaceutical Chemistry

* Determination of quality markers in a polyherbal formulation using a developed and validated RP-HPLC
method

» Status: Completed
4. Sala Ahmed | MPhil, Pharmaceutical Chemistry

* Reverse phase HPLC method development for the simultaneous determination of Mangiferin, azadirachtin
and gallic acid in a polyherbal formulation

» Status: Completed
5. Tabitha Agorku | MPhil, Pharmaceutical Chemistry

* High performance liquid chromatography (HPLC) method development, validation and exploratory
bioavailability study of Antiaris

* Status: Completed
6. Abdulai Abdul-Razak | MPhil, Pharmaceutical Chemistry (Co-Supervisor)

* The efficiency of ceramic filtration system in removing selected contaminants from domestic water: A case
study of Amansie central district

* Status: Completed
7. Ivy Nyarko | MPhil, Pharmaceutical Chemistry

* Development of RP-HPLC and dissolution methods for artemether and lumefantrine fixed dose
combinations

» Status: Completed
8. Razak Abdulai | MPhil, Pharmaceutical Chemistry

» Filtration systems for water bodies contaminated by heavy metals from mining activities and
Pharmaceutical residues

* Status: Completed
9. Safrega Baba | MPhil, Pharmaceutical Chemistry

* Development and Validation of Stability indicating HPLC Method for the Simultaneous Estimation of
Selected Analgesics

» Status: Completed
10. Amenu J.D. | MPhil, Pharmaceutical Chemistry

» Isolation, characterization and microbial assay of a biomarker and development of HPLC method for the
quality control of the roots of securinega virosa

* Status: Completed
11. Appiah S.O. | MPhil, Pharmaceutical Chemistry

* Novel UV-visible spectrophotometric determination of quinine sulphate powder and formulations using
hydrotropic characterization

» Status: Completed
12. Onilimor P.J. | MPhil, Pharmaceutical Chemistry

* Phytochemical screening, antimicrobial, antioxidant and anti-inflammatory activities of methanolic,
aqueous and pet ether extracts of the leaves of allanblackia parviflora (A. Chevalier)

* Status: Completed
13. Amoah E. | MPhil, Pharmaceutical Chemistry
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* Phytochemical screening, antimicrobial, anti-oxidant and anti-inflammatory activities of methanolic,

aqueous and pet ether extracts of the stem bark of allanblackia parviflora (A. Chevalier)
* Status: Completed

14. Agyeman O.S. | MPhil, Pharmaceutical Chemistry 2015
* Novel application of hydrotropic characterization in the quantitative estimation of furosemide, cefuroxime

axetil and metronidazole in pure powders and tablet formulations
» Status: Completed

15. Quartey A.K. | MPhil, Pharmaceutical Chemistry 2014
* Phytochemical, antimicrobial, and antioxidant constituents of trichilia monadelpha (thronn) J.J. de Wilde

and trichilia tessmannii (harms) both of the family meliaceae
» Status: Completed

MPHIL CO-SUPERVISION (Dept. Pharmaceutical Chemistry)

16. Anthony Kwabena Appiah-Yeboah | MPhil, Pharmaceutical Chemistry (Co-Supervisor) 2025
* Bioactivity assessment, isolation and characterization of the methanolic extract of the stem bark of

Aningeria Robusta
» Status: Completed

17. Sackitey Solomon | MPhil, Pharmaceutical Chemistry (Co-Supervisor) 2023
* RP-HPLC method development and validation to identify and quantify selected NSAIDS and

PARACETAMOL in herbal preparations
» Status: Completed

18. Daniel Nimako Amprako | MPhil, Pharmaceutical Chemistry (Co-Supervisor) 2022
* Development and validation of HPLC method for the Analysis of SILDENAFIL, TADALAFIL, and

VARDENAFIL and application in the analysis of some herbal Aphrodisiacs on the Ghanaian market
» Status: Completed

19. Kingsley Ofori-Atta | MPhil, Pharmaceutical Chemistry (Co-Supervisor) 2022
* Quantification of caffeine in some energy drinks on a selected Ghanaian market using HPLC
* Status: Completed

20. Selina Baffour-Antwi | MPhil, Pharmaceutical Chemistry (Co-Supervisor) 2022
* Qualitative and Quantitative evaluation of cryptolepis-based herbal anti-malarial formulations in Ghana
» Status: Completed

21. Alberta ADE | MPhil, Pharmaceutical Chemistry (Co-Supervisor) 2019
» Synthesis, characterization and antimicrobial studies of novel 2,4-Dinitrophenylhydrazone derivatives
» Status: Completed

22. Monica Mame Soma Nyansa | MPhil, Pharmaceutical Chemistry (Co-Supervisor) 2017
* Development of HPLC method for the simultaneous estimation of Paracetamol/Tramadol Hydrochloride in

fixed-dose combination tablets
» Status: Completed

23. Prince Yeboah | MPhil, Pharmaceutical Chemistry (Co-Supervisor) 2016
* The use of surrogate reference standards in quantitative HPLC: A case study of the analysis of Amlodipine

and Lisinopril tablets
» Status: Completed

MPHIL CO-SUPERVISION (Dept. Pharmaceutics)
24.Yir-Erong B. | MPhil, Pharmaceutics (Co-Supervisor) 2018
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* Formulation and characterisation of novel quinine oral thin film for paediatric use

» Status: Completed
25. Owusu F.W.A. | MPhil, Pharmaceutics (Co-Supervisor)

 Formulation of nifedipine suppository to meet the needs of the severely ill and geriatric hypertensive
patients

* Status: Completed

UNDERGRADUATE PROJECT SUPERVISION

1. Agyepong Maame Serwaa Akosua | Undergraduate Project
» UV-spectrophotometric method development and validation for the analysis of timolol ophthalmic
preparations
* Status: Completed
2. Osei Priscilla | Undergraduate Project
* Optimization of aspirin synthetic parameters using the plackett-burman experimental design
» Status: Completed
3. Amoah Samuel Kwaku | Undergraduate Project
* Detection of adulterant antibiotics in selected herbal products
* Status: Completed
4. Nabil Mohammed Opoku | Undergraduate Project
* Quality assessment of anhydrous cyproheptadine hydrochloride
» Status: Completed
5. Abudu Ibrahim | Undergraduate Project
* Quality assessment of selected anti-infective herbal products available in Koforidua, Ghana
» Status: Completed
6. Svetlana Ami Mortoo | Undergraduate Project
* Forced degradation studies on two different batches of paracetamol and aspirin tablets using UV
spectrophotometry
» Status: Completed
7. Boafo Sampson | Undergraduate Project
* Evaluation of heavy metals concentrations in some selected anti-infective herbal medicines using atomic
absorption spectroscopy
» Status: Completed
8. Awotwe David | Undergraduate Project
* The effect of pH and determining the appropriate water for reconstitution of Lonart suspension
* Status: Completed
9. Kwarteng Andrews Sarpong | Undergraduate Project
* Determination of heavy metals in polyherbal product
» Status: Completed
10. Charles Boateng | Undergraduate Project
* Investigating the impact of pH and constituents of feminine hygiene products on female reproductive
health
» Status: Completed
11. Kobbla Norbert Dodze | Undergraduate Project
* Quality assessment of different brands of sustained release diclofenac tablets on the Ghanaian market
» Status: Completed
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12. Nana Addo Asiako | Undergraduate Project
* pH determination and heavy metal analysis of selected batches of a polyherbal distillate
* Status: Completed
13. Acquah Paapa Kojo | Undergraduate Project
* Assessment of the acid neutralizing capacity of pepsa mixture
* Status: Completed
14. Darko Roselyn Asiaa | Undergraduate Project
* A comparative study of microbial contamination, pH and assay of pediatric antipyretic syrups in different
batches of the same brand
» Status: Completed
15. Sakina Sambo | Undergraduate Project
* A comparative chemical analysis of glucose content of white rice, brown rice and basmati rice
» Status: Completed
16. Angelique Nana Esi Osei-Alomele | Undergraduate Project
* Analysis of alcoholic bitters on the Ghanaian market
» Status: Completed
17. Oware Boateng Junior | Undergraduate Project
* Adulteration of alcoholic beverages with aphrodisiacs
» Status: Completed
18. Twum Amankwaah | Undergraduate Project
» Heavy metal analysis of selected local alcoholic beverages in Ghana
» Status: Completed
19. Kelvin Mainoo | Undergraduate Project
* Quality control of local alcoholic bitters
» Status: Completed
20. Quayson Emmanuel Amponsah | Undergraduate Project
* Determination of Iron content in selected Ghanaian Herbal Blood Tonics
» Status: Completed
21. Stephen KofiMills | Undergraduate Project
* Accessing the metallic contents in local aphrodisiac herbal products manufactured in Ghana
» Status: Completed
22. Kwabena Wireko | Undergraduate Project
* Spectrophotometric Determination of Artemether Lumefantrine suspensions marketed in Kumasi
Metropolis
» Status: Completed
23. Ohenewaah Onwona-Nyarko | Undergraduate Project
* Determination of Acetic Acid of Vinegar using Visual End Point Determination and Potentiometry
» Status: Completed
24. Richard Akoto Obuobi | Undergraduate Project
* Determination of Heavy Metals in some selected skin lightening creams on the Ghanaian market
» Status: Completed
25. Bernard Tsibu Baiden | Undergraduate Project
* Determination of Benzoic Acid levels in Soft Drinks using UV Spectroscopy
» Status: Completed
26. Agnes Harris | Undergraduate Project
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* Evaluating the quality and some characteristic properties of locally produced honey sold in Kumasi using
branded and unbranded honey samples
* Status: Completed
27. Eduah Bridget Otiwaa | Undergraduate Project
* The use and quality assessment of cyproheptadine and cyproheptadine containing products in Ghana
* Status: Completed
28. Ayipeh Emmanuel | Undergraduate Project
* Determination of metals in tap water using atomic absorption spectrometry
» Status: Completed
29. Gifty Donkor | Undergraduate Project
* The Quality of Alcohol rub hand sanitizers on the Ghanaian Market
» Status: Completed
30. Agyemang Joel Kweku | Undergraduate Project
* Evaluation and analysis of the quality of selected metronidazole infusions on the Kumasi market
» Status: Completed
31. Josephine Gyankama Bediako | Undergraduate Project
» Comparative determination of dexamethasone content in pharmaceutical tablets and dompe dompe tablets
» Status: Completed
32. Oduro Kofi | Undergraduate Project
» Heavy metals analysis in agriculture
* Status: Completed
33. Afua Ohemaa Amponsah-Kaakyre | Undergraduate Project
» Using ultra-violet spectroscopic techniques to assess the quality of some brands of paracetamol infusions
» Status: Completed
34. Jerry Abieku Sackson | Undergraduate Project
» Comparative analysis of raw honey and processed honey in the Kumasi, Ghana
» Status: Completed
35. Samuel Whyte Emmanuel Henaku | Undergraduate Project
* Quality assessment of Herbal anti-malarials preparations on the Ghanaian Market
» Status: Completed
36. Erika Owusu | Undergraduate Project
* Assessment of heavy metals introduced into food (Fufu) through milling process
» Status: Completed
37. Gerald Acheampong | Undergraduate Project
* Anti-infective and modulatory properties of Casein
» Status: Completed
38. Samuel Ntow-Aninkora | Undergraduate Project
* Anti-infective and modulatory properties of Casein
» Status: Completed
39. Odira Ubajaka | Undergraduate Project
* TLC and UV-Visible determination of suspected Tadalafil in Alcoholic beverages
* Status: Completed
40. Annabelle Udeagbala | Undergraduate Project
* TLC and UV-Visible determination of suspected Tadalafil in Alcoholic beverages
* Status: Completed
41. Erica Owusu Ansah | Undergraduate Project
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* Physicochemical Analysis of Ghanaian Alcoholic Bitters
» Status: Completed
42. Jeffrey-King Nsiah Darko | Undergraduate Project
* Phyto-Chemical Analysis of Ghanaian Alcoholic Bitters
» Status: Completed
43. Derrick Buku | Undergraduate Project

* Sub-Acute Toxicity Testing of Three Brands of Alcoholic Bitters Suspected to Contain Aphrodisiacs

» Status: Completed
44. Koduah Asare | Undergraduate Project
* Analysis of Alcoholic Bitters on the Ghanaian Market
» Status: Completed
45. Kwarteng Yaw Obeng | Undergraduate Project
» UV-Visible Spectrophotometric Quantification of Nifedipine Tablets using Mixed Hydrotropic
Solubilization
» Status: Completed
46. Asare Peter Kenneth | Undergraduate Project
» UV-Visible Spectrophotometric Quantification of Nifedipine Tablets using Mixed Hydrotropic
Solubilization
» Status: Completed
47. Ehoneah O. | Undergraduate Project
* Qualitation & quantification of tryptophan in Hausa Koko; a local Ghanaian beverage
» Status: Completed
48. Danson D.A. | Undergraduate Project
* Qualitation & quantification of tryptophan in Hausa Koko; a local Ghanaian beverage
» Status: Completed
49. Offei S.K. | Undergraduate Project
» UV spectrophotometric assay of nifedipine available in the Kumasi metropolis
» Status: Completed
50. Amponsah E. | Undergraduate Project
» Test for antimicrobial activity and antioxidant activity of a selected herbal soap
» Status: Completed
51. Yirenkyi K. | Undergraduate Project

» UV-Visible spectrophotometric quantification of diclofenac sodium powder and tablets using hydrotropic

solubilisation
» Status: Completed
52. Emmanuel Oppong Nketia | Undergraduate Project

» UV-Visible Spectrophotometric Quantification of Quinine Sulphate Powder and Tablets using Hydrotropic

Solubilisation
» Status: Completed

53. Frimpong-Manso K. | Undergraduate Project
* Aqueous solubilisation and UV spectrophotometric assay of albendazole by hydrotropy
* Status: Completed

54. Boateng R.A. | Undergraduate Project
* Aqueous solubilisation and UV spectrophotometric assay of albendazole by hydrotropy
* Status: Completed

55. Essel E.T. | Undergraduate Project
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* Quantitative and qualitative determination of hydroquinone content in surveyed skin bleaching creams on
the Ghanaian market
* Status: Completed
56. Agbetiameh B.K. | Undergraduate Project 2017
* Quantitative and qualitative determination of hydroquinone content in surveyed skin bleaching creams on
the Ghanaian market
» Status: Completed

57. Kumi N.O. | Undergraduate Project 2016
* An audit of research activities of the Department of Pharmaceutical Chemistry (1971-2015), Faculty of
Pharmacy
» Status: Completed
58. Appiah O.J. | Undergraduate Project 2016

* Analysis of furosemide tablets using hydrotropic solubilisation
» Status: Completed

59. Evbodi O.A. | Undergraduate Project 2016
* The hazards of food dyes
* Status: Completed

60. Torsoo P.M.R. | Undergraduate Project 2016
* Assay of brands of cefuroxime axetil tablet formulations using hydrotropic solubilisation
» Status: Completed

61. Nyanor A.K. | Undergraduate Project 2016
» Assay of various brands of metronidazole tablets using hydrotropic methods
* Status: Completed

62. Otchere R.O. | Undergraduate Project 2016
* Quality assessment and phytochemical screening of herbal anti-diabetic product
» Status: Completed

63. Edzia R.Y. | Undergraduate Project 2015
* Qualitative and Quantitative analysis of two brands of metronidazole tablets on the Ghanaian market
* Status: Completed

64. Ndigwe C.G. | Undergraduate Project 2015
* Quality assessment of some selected brands of amoxicillin and clavulanic acid combination antibiotic

tablets on the Ghanaian market
» Status: Completed

65. Attafua A.A. | Undergraduate Project 2015
* Quality characteristics of Shea cosmetics produced by local manufacturers
» Status: Completed

66. Anyinam-Boateng A. | Undergraduate Project 2015
* Quantitative assessment of lead in selected brands of lipsticks
» Status: Completed

67. Ofodum C.A. | Undergraduate Project 2015
* Analysis of health insured amoxicillin capsules and non-health insured amoxicillin capsules in Kumasi

Metropolis
» Status: Completed

68. Seidu I. | Undergraduate Project 2014
* The stability study of various brands of paracetamol syrups under various storage conditions using UV-

visible spectrophotometry
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* Status: Completed
69. Darkwa K.K. | Undergraduate Project
* Assessment of stability status of some selected freshly prepared yoghurt - a case study on KNUST campus
* Status: Completed
70. Arthur R.L. | Undergraduate Project
* Investigating the bioactive constituents of the leaves, the stem and the root of nephrolepis exaltata
(lomariopsidaceac)
» Status: Completed
71. Ofori-Antwi V. | Undergraduate Project
* Assessing the quality of Metformin hydrochloride oral solid dosage preparations on the Ghanaian market
» Status: Completed
72. Sarpong Y. | Undergraduate Project
* Determination of percentage content and dissolution profiles of Lumefantrine in local and imported
generics of Artemether-Lumefantrine Combination Products on the Kumasi Metropolis
» Status: Completed
73. Selma R.A. | Undergraduate Project
* A Qualitative and Quantitative Assay of Diclofenac sodium tablets in the Kumasi Metropolis
» Status: Completed
74. Appiah B.C. | Undergraduate Project
* The pH, phosphoric acid content and health implications of commonly available brands of Coca Cola soft
drink on the local Ghanaian market
» Status: Completed
75. Owusu P. | Undergraduate Project
* The effect of magnetized water on streptozotocin-induced diabetic rats
» Status: Completed
76. Abilba F.A. | Undergraduate Project
* Effects of combined product of alkaline and magnetized water on streptozotocin-induced diabetic rats
» Status: Completed
77. Asamoah A.A. | Undergraduate Project
* The effect of alkaline water on streptozotocin-induced diabetic rats
» Status: Completed
78. Mills S. | Undergraduate Project
» Effects of Magnetized water on the solubility of paracetamol tablets
* Status: Completed
79. Mozu R.E. | Undergraduate Project
* The effect of Magnetized water on pharmaceutical analysis using Amodiaquine Hydrochloride as
prototype
» Status: Completed
80. Abugri L. | Undergraduate Project
* Establishing a stability protocol for Herbal products; a case study of three Herbal Antimalarial oral
products
* Status: Completed
81. Teye F. | Undergraduate Project
* Development of stability protocol for oral herbal products (a case study of three locally manufactured
products against piles)
» Status: Completed
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82. Afosah D. | Undergraduate Project
* Qualitative and Quantitative assessment of Herbal creams and ointments on the Ghanaian Market: A case
study of their Corticosteroid content with respect to Dexamethasone
* Status: Completed
83. Appiah G. | Undergraduate Project
* Semi-literacy in Herbal Medicine practice in Ghana
» Status: Completed
84. Gyekye E.P. | Undergraduate Project
* The effect of sugar on some vitamins in Multivitamin syrups
» Status: Completed
85. Nikoi J.A.K. | Undergraduate Project
* Vitamin deficiency- the silent killer. A case study with UV and lodimetric analysis
» Status: Completed
86. Blay T.D. | Undergraduate Project
* Vitamin deficiency- the silent killer. A case study using HPLC analysis
» Status: Completed
87. Osei-Appau G. | Undergraduate Project
* Vitamin deficiency- the silent killer. A case study using HPLC analysis
» Status: Completed
88. Nkansah A.A.K. | Undergraduate Project
* The effect of Temperature on the stability of Chloramphenicol capsules
» Status: Completed
89. Arthur-Hayward N. | Undergraduate Project
* Market Survey and quality assessment of Anthelmintics (A case study of Mebendazole and Albendazole)
» Status: Completed
90. Cobbina E. | Undergraduate Project
* Qualitative and quantitative assessment of herbal ointment on the Ghanaian Market. A case study of their
Sulphur content
* Status: Completed
91. Osei T.E. | Undergraduate Project
* Quality Evaluation and Market Survey on some brands of Artesunate
» Status: Completed
92. Buabeng B. | Undergraduate Project
* Quality Evaluation of some brands of Artesunate tablets in the Kumasi Metropolis
» Status: Completed

Selected conferences and seminars attended.

KNUST

11th Biennial Scientific Conference | College of Health Sciences, KNUST
* Participant

2007

2007

2007

2006

2006

2006

2005

2005

2005

2004

2004

2025

Microsoft 365 Training | UITS Laboratory KNUST 13th February 2025

* Participant

Trainer of Trainees Workshop and Retreat | College of Health Sciences Senior Staff, Rock City
* Participant

10th Biennial Scientific Conference | College of Health Sciences, KNUST
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* Participant

Skilled Helper Programme | Novel Counselling Skills Course, KNUST Counselling Center July 2022

* Short course in Novel Counselling Skills
Workshop on Online Promotion System | CHS
* Participant
Training Workshop on Accreditation Processes and Procedures | QAPO
* Participant
Workshops on University Policies | QO4APO/CHS
* Guidelines for Tracer Studies Policy - May 2022
* Peer-peer Evaluation on Teaching Policy - April 2022
» Maintenance Policy - April 2022
* Admissions Policy - March 2022
* Ethical Review Policy - March 2022
* Anti-sexual Harassment Policy - March 2022
* Disability Policy - March 2022
Continuous Professional Development | Stress and Anxiety in Academia
* Participant
Orientation Programme for Deans and Heads of Department | KNUST
* Participant
9th Biennial Scientific Conference | College of Health Sciences, KNUST
* Participant and Chairman of Parallel Session
KNUST Summer School Workshops | KNUST
* Annual participant
KNUST Online Teaching Training Course | KNUST
* Psychology of Online Teaching
* Introduction to KNUST Virtual Academic Space
* Uploading of Resources and Setting up Activities Online
* Conducting Live Class Teaching
* Developing Study Guide
* Quality Metrics for Online Learning
* Online Assessment
Invigilation Workshop for all Senior Members | KNUST
* Participant

Predatory Journal/Publishers, Plagiarism and Digital Commons | KNUST

* Participant
8th College of Science Scientific Conference | KNUST
* Participant

June 2022
April 2022

2022

March 2022
January 2022
2021
2021-2025

September 2020-2022

November 2019
November 2019

2019

Author Workshop: How to Publish in Peer Review Journals | Elsevier, IDL Conference Centre,

KNUST
* Participant
Electronic Learning and Virtual Classroom | CDC, CHS, KNUST
* Participant
BSU II Research Conference | Golden Bean Hotel, Kumasi
* Presenter and Participant
BSUII Workshop Write Shop | University of Ghana, Accra
* Participant
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Administration and Leadership Workshop for Deans and Heads of Department | KNUS7September 2014-2(
* Annual participant

BSUII Work Package 111 | Short Course on Water and Sanitation April 2016
* Participant
CDC-CHS StaffDevelopment Workshop | KNUST April 2016

* Participant
BSUII Workshop: Building Research Capacity to foster Academia-Industry Partnership | KNUSTMarch 20
* Participant

CDC-CHS StaffDevelopment Seminar | KNUST February 2016
* Participant

1st National Conference on Problem-Based Learning and E-learning | KNUST September 2016
* Participant

KNUST Summer School Workshops | KNUST August 2013-2018
* Annual participant

Training Workshop on Quality Control of Drugs | Action Medeor (Germany) and KNUST 2013

* Participant

1st, 2nd and 6th Annual Scientific Conference | College of Health Sciences, KNUSTAugust 2009, 2008, 2013
* Participant and Presenter

Training Workshop on Quality Control of Drugs | Action Medeor (Germany), KNUST and Food and

Drugs Board July 2009
* Participant

Enhancing Education of Health Professionals through Strategic Leadership and ManagementJanuary 2009
* Participant | Seminar for Senior Members, CHS, KNUST

Trainer of Trainers' Workshop on Competency Based Teaching and Learning August 2006
» Participant | Quality Assurance and Planning Units, KNUST
TaliffWorkshop | KNUST 2005

* Participant

Induction and Training Workshop for Newly Appointed Lecturers | Quality Assurance and

Planning Unit, KNUST August 2005
* Participant

Training of Trainers' Workshop on MCQ | Quality Assurance and Planning Units, KNUST = March 2004
* Participant

Seminar on 'Improved Pedagogy and Research Proposal Writing' | Quality Assurance and Planning

Units, KNUST February 2004
* Participant

National

Continuing Professional Development | Pharmacy Council 2014-2025
* Annual participant

Pharmaceutical Society of Ghana Annual General Meetings/Conferences | Various Venues2001-2009, 2013-2!
* Regular participant and presenter

COBREG 2020 Virtual Conference | Online 2020
* Presenter
Continuing Professional Development | Pharmacy Council and USAID July 2014

* Participant
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Packaging Workshop for Stakeholders | Institute of Packaging Ghana July 2014
* Resource Person

Continuing Education/Professional Development | Pharmacy Council and Ghana Health Service 2013
* Participant

GMP for Quality Control and Production Managers | Food and Drugs Board January 2008
* Participant

Pharmacy Council Continuing Education/Professional Development | Pharmacy Council 2004-2009

* Regular participant

International

10th Calestous Juma Executive Dialogue | Kumasi, Ghana September 2024
* Resource Person

International Webinar: Revisiting Antacids for Gastric Acidity | Shalina Healthcare Ltd June 2021

* Resource Person
Third Topical Meeting | United Nations Commission on Narcotic Drugs, Vienna (Virtual) October 2020
* Member of Ghanaian Delegation
Webinar: Malaria Elimination - Current Status, Challenges and Strategies | Shalina Healthcare July 2020
* Participant
First Topical Meeting | United Nations Commission on Narcotic Drugs, Vienna (Virtual)  24-25 June 2020
» Member of Ghanaian Delegation (Speaker)
Association of Commonwealth Universities Representative | African Academy of Sciences SeminarQOctober 21
* Representative - Royal Society, UK
Academy of Pharmaceutical Scientists (APS) - The Science of Medicine ConferenceSeptember 2012, 2011, 2!
* Presenter and Participant | Nottingham University, UK
American Association of Pharmaceutical Sciences (AAPS) Annual Meeting and Exposition |
Washington DC, USA November 2011
* Presenter
Research Ethics Training: "Identifying Vulnerability and Taking Responsibility in Research" June 2011
» Participant | University of Greenwich, UK
Developing the Inquiring Mind for Lifelong Skills | The Higher Education Academy/University of

Greenwich April 2010
* Participant | Medway, UK
Teaching Learning and Assessing in Higher Education | University of Greenwich, UK April 2010

* Participant

Maximizing the Impact: Science and Technology for Society | Commonwealth Scholarship

Commission, UK March 2010
* Participant

Demonstrators Workshop | The Engineering Subject Centre and UK Physical Science Centre,

University of Greenwich March 2010
* Participant

Roles and Responsibility Training Event | University of Greenwich, UK December 2009
* Participant

Equal Opportunities and Diversity Essentials Course | University of Greenwich, UK October 2009

* Participant
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Other Professionally Related Experience

Chair, PhD and MPhil Vivas | School of Graduate Studies, KNUST 2025 to date
* Chaired 7 PhD and 20 MPhil vivas examinations
External Assessor (Senior Lecturer to Professorial Rank) | Center for Plant Medicine Research,

Mampong 2025
* Promotion assessment
External Assessor (Lecturer to Senior Lecturer) | School of Pharmacy, UDS, Tamale 2024

* Promotion assessment
External Assessor (Senior Lecturer to Professorial Rank) | School of Pharmacy, University of Ibadan,

Nigeria 2024
* Promotion assessment
Invited Lecturer | China Pharmaceutical University, Nanjing, China March 2021-2025

* Annual invited lectureship
External Moderator for Pharmaceutical Chemistry | School of Pharmacy, University of Development

Studies, Tamale 2023-2024
* Moderation of examinations and curriculum

External Assessor (Lecturer to Senior Lecturer) | School of Pharmacy, University of Ghana 2022
* Dr. Michael Lartey - Promotion assessment

External Examiner for PhD Thesis | Institute of Environmental Studies, University of Ghana 2021
* Emmanuel Kaboja Magna - PhD examination

External Assessor | Appointment and Promotions Board, Sunyani Technical University April 2021
* Promotion assessment

External Examiner for MPhil Thesis | Department of Chemistry, University of Ghana 2016 to date

* Perpetual Aboabea Anom (2021)
* Emmanuel Yeboah Bonsu (2020)
* Coffie Eric (2019)

* Tofah Kwasi Pascal (2019)

External Examiner for PhD Thesis | China Pharmaceutical University, China May 2018
* PhD thesis examination

Internal Examiner for PhD Theses | Department of Pharmaceutical Chemistry, KNUST 2016-2024
* Regular internal examiner for PhD examinations

Internal Examiner for PhD Theses | Department of Pharmacognosy, KNUST 2016

* PhD thesis examination
External Assessor (Lecturer to Senior Lecturer) | School of Applied Science and Arts, Accra

Polytechnic 2016
* Promotion assessment
External Examiner for PhD Thesis | Department of Chemistry, University of Ghana 2016

* PhD thesis examination
Visiting Senior Lecturer | Madonna University, Nigeria June 2016 to Date
* Regular visiting lectureship
Internal Examiner for MSc and MPhil Theses | Department of Pharmaceutical Chemistry, KNUST2005, 2014
* Two (2) MSc. theses examined
* Thirteen (13) MPhil theses examined

Assistant Lecturer/Academic Support | University of Greenwich School of Science, UK 2010-2012
* Provided academic support and assistance in teaching
Aim-High Associate | University of Greenwich, UK 2011
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* Motivated and helped young adults from lowest socio-economic categories and ethnic minority
backgrounds
* First in family to progress to Higher Education
* Taught and supported mentees with challenging chemistry topics
Research Skills Online Completion Certificate | University of Greenwich, UK December 2010
* Career Planning in the Sciences
* Ethics 1: Good Research Practice
* Ethics 2: Working with Human Subjects
* Getting Published in the Sciences
* IP in the Research Context
* Managing your Research Supervisor or Principal Investigator
* Project Management
* Research Methods (Sciences)
* Research Methods in Literature Review
» Selecting a Conference, Presenting and Networking
Part-Time Lecturer | Dispensing Technology Department, Kumasi Polytechnic 2003-2005
* Lectured in Dispensing Technology

Record of Service to the Community (University/National/International) with dates
University Service (KNUST)

Head of Pharmaceutical Chemistry | Department of Pharmaceutical Chemistry Nov. 2022 to Date
* Leading the department and chairing all board meetings

Head of Herbal Medicine | Department of Herbal Medicine August 2020 - October 2022
* Led the Department of Herbal Medicine and chaired board meetings

Head of Pharmaceutical Chemistry | Department of Pharmaceutical Chemistry Aug 2014 to Jul 2015
* Leading the department and chairing all board meetings

Head of Pharmaceutical Chemistry | Department of Pharmaceutical Chemistry Aug 2015 to Jul 2016
* Leading the department and chairing all board meetings

Head of Pharmaceutical Chemistry | Department of Pharmaceutical Chemistry Aug 2016 to Jul 2017
* Leading the department and chairing all board meetings

Coordinator Problem-Based Learning | College of Health Sciences December 2024 to Date

* Coordinating PBL initiatives across the College
Chairman | Commitee to review programme selection of applicants into the college of health science23/02/2026
* To Review programme selection of applicants into the College of Health Sciences
Chairman | Herbal Medicine Curriculum Review Committee, Faculty of Pharmacy May 2022
* Chaired the committee to review the Herbal Medicine curriculum
Chairman | Parallel Session - College of Health Sciences 9th Biennial Scientific ConferenceSeptember 2021
* Chaired a parallel session at the conference

Chairman | Faculty Excellence Awards Committee July 2021
* Chaired the committee for Faculty Excellence Awards

Chairman | Establishment of Liaison Office Committee July 2021
* Chaired committee for establishing a Liaison Office

Chairman | Departmental Board, Pharmaceutical Chemistry August 2014 - July 2017
* Chaired departmental board meetings

Chairman | Committee to Investigate Examination Fraud Allegation 2013/2014 Academic Year

25| PROFESSOR ISAAC AYENSU



* Investigated examination fraud allegation against Mr. Lawrence Mensah

Vice Chair | College of Health Sciences Retreat Planning Committee May 2024
» Assisted in planning the College retreat

Vice-Chair | Faculty Production Unit Management Committee 2017 to Date
* Serving as Vice-Chair of Production Unit

Subcommittee Chair | 11th Biennial Scientific Conference 2025
* For the planning commitee.

Leader | Koforidua Invigilation Team - Nursing and Midwifery Terminal Examination July 2025
* Led invigilation team for professional examinations

Faculty Reviewer | College Excellence Awards 2025
* Reviewer for College Excellence Award nominations

Supervisor | 2026 Students Field Trip 2025
* Supervisor for 2026 Students Field Trip

Member | KNUST Advancement and Alumni Relations Office Board 2025
» Committee member for KNUST Advancement and Alumni Relations Office Board

Member | College Biennial Scientific Conference Planning Committee 2025

» Committee member for conference organization

Resource Person | Open Forum on "Evaluation of Student's Report' - Faculty Retreat November 2022
* Presented on evaluation of student reports

Member | Cape Coast Invigilation Team - Nursing and Midwifery Terminal Examination =~ November 2024
* Invigilation team member for professional examinations

Member | Sekondi Invigilation Team - Nursing and Midwifery Terminal Examination September 2023
* Invigilation team member for professional examinations

Leader | Sekondi Invigilation Team - Nursing and Midwifery Terminal Examination November 2022
* Led invigilation team for professional examinations

Member | College Board, College of Health Sciences August 2020 to Date
» Serving on the College governing board

Member | Faculty Board, Faculty of Pharmacy and Pharmaceutical Sciences August 2020 to Date
* Serving on the Faculty governing board

Member | College of Health Sciences Retreat Planning Committee May 2022
» Committee member for College retreat planning

Member | College of Health Sciences Committee for KNUST Olympic StaffGames May 2022
» Committee member for staffgames organization

Member | College of Health Sciences Excellence Award Ceremony Planning Committee January 2022
» Committee member for Excellence Award ceremony

Leader | Korle-Bu Invigilation Team - Nursing and Midwifery Terminal Examination November 2021
* Led invigilation team for professional examinations

Reviewer | Maiden CHS Research Grant Applications October 2021
*» Reviewed research grant applications

Member | College Students and StaffPsychological Health Committee July 2021

» Committee member for psychological health initiatives

Member | Sub-committee for Staffand Leadership - FIDLET Strategy 7, College Strategic Plan  May 2021
* Member of strategic plan implementation committee

College Representative | Association of Commonwealth Universities Champions November 2020
* Represented the College as ACU Champion

Leader | Asankragua RGN Invigilation Team - Nursing and Midwifery Terminal Examination August 2020
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* Led invigilation team for professional examinations

Scrutineer | Election of Convocation Representatives on University Council 13th November 2019
* Served as scrutineer for university council elections

Leader | Kokofu RGN Invigilation Team - Nursing and Midwifery Terminal Examination June 2019
* Led invigilation team for professional examinations

Member | Reaccreditation Committee, Faculty of Pharmacy February 2019

» Committee member for faculty reaccreditation

Experiential Training Coordinator | Faculty of Pharmacy and Pharmaceutical SciencesMarch 2019 to Date
* Coordinating experiential training for students

Member | Herbal Medicine Curriculum Review Committee May 2018
» Committee member for curriculum review

Member | PharmD Curriculum Review Committee April 2018
* Committee member for PharmD curriculum review

Non-Professorial Representative | Academic Board of KNUST (College of Health Sciences)February 2017 - V
* Represented non-professorial staffon the Academic Board

Three-Time Head | Department of Pharmaceutical Chemistry 2014-2017
* Aug 2014 - July 2015
» Aug 2015 - July 2016
* Aug 2016 - July 2017

Member | Faculty Board, Faculty of Pharmacy August 2014 - July 2017
* Served on the Faculty Board

Member | Reallocation of Provost and Accounts Office Spaces Committee March 2017
» Committee member for office space reallocation

Member | Committee for Evaluation of Faculty for African Quality Rating Mechanism April 2017
* Evaluated faculty for quality rating

Member | PharmD Top-up Implementation Committee February 2017
» Committee member for PharmD top-up implementation

Member | PharmD Implementation and Monitoring Committee August 2014 to Date
» Committee member for PharmD program implementation

Industrial Coordinator | PharmD Elective October 2016 to Date
* Coordinating industrial placements for PharmD students

Member | College Board, College of Health Sciences August 2014 to Date
» Serving on the College governing board

Member | Committee to Draft Syllabus for Graduate Entry to PharmD, FPPS April 2016

» Committee member for graduate entry syllabus development

Member | Review Committee on Proposed Creation of Department of Pharmaceutical Microbiology 2016
* Reviewed proposal for new department

Secretary/Member | Adhoc Committee for NCTE Support Letter on PharmD Accreditation 2016
* Drafted letter of support for PharmD accreditation

Member | Committee to Review Syllabus of Sports Science and Exercise 2016
* Reviewed and contributed to syllabus revision

Graduate Programmes Coordinator (Acting) | Faculty of Pharmacy July - December 2013
* Coordinated graduate programmes on acting basis

Member | Department of Pharmaceutical Chemistry Board 2003 - 2014
* Served on departmental board

Member | Faculty Examiner's Board, Faculty of Pharmacy 2003 to Date

27| PROFESSOR ISAAC AYENSU



» Serving on Faculty Examiner's Board

Faculty Representative | Faculty of Biosciences Board 2007 - 2009
* Represented Faculty of Pharmacy on Biosciences Board

Head of Quality Control Unit | Department of Pharmaceutical Chemistry 2007 - 2009
* Led the Quality Control Unit

Deputy Director | MSc. Programme, Department of Pharmaceutical Chemistry 2007 - 2009
* Served as Deputy Director for MSc programme

Academic Tutor | B.Pharm, BSc. Herbal Medicine and PharmD Students 2003 - 2009
* Provided academic tutoring to undergraduate students

Mentor | FAMU and KNUST Collaboration 2008
* Served as mentor for collaborative programme

Member | Delegation for Inspection of Vacation Training 2003 - 2008
* Inspected vacation training of Pharmacy students

Head/Member | Organizing Team for Industrial Trips - MSc. Pharmaceutical Analysis 2005 - 2008
* Organized industrial trips for MSc students

Resource Person | ""The State of the Faculty of Pharmacy" - Faculty Retreat 2007
* Presented a young lecturer's view on the Faculty

Secretary | PharmD Curriculum Development Committee 2004

» Served as secretary for curriculum development

National

Chairman | Accreditation of programs at UHAS- Ghana Tertiary Education Commission (GTEC) 2024
* Assessed the university capability of starting a new program

Chairman | Academic, Social, Research Pharmacists Association (ASRPA) - Pharmaceutical Society

of Ghana August 2021 - 2023
* Led the academic and research wing of PSGH

Chairman | Academic, Social, Research Pharmacists Association (ASRPA) - Pharmaceutical Society

of Ghana August 2019 - 2021
* Led the academic and research wing of PSGH
Member | Traditional Medicine Practice Council June 2024 to Date

* Serving on the governing board of the Traditional Medicine Practice Council
Member | Technical Working Group to Review Monograph of Medicinal Plants Document (2009)

September 2022 to Date
 Reviewing the national monograph of medicinal plants
Member | Traditional Medicine Practice Council June 2022 - 2024
* Served on the governing board
Member | Malaria Case Management Guideline Document Review Committee September 2022
* Reviewed national malaria case management guidelines
Member | Review Committee - National Antimalarial Drug Policy June 2022

* Reviewed and contributed to national antimalarial drug policy
Resource Person | Quality Control and GMP Training - Universal Plant Medicine and Traditional

Healers Association March 2022
* Provided training on quality control and GMP

External Examiner | School of Pharmacy-Central University 2025
* Moderates and review the curriculum of the School.

External Assessor (Lecturer to Senior Lecturer) | School of Pharmacy, University of Ghana 2022
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* Assessed Dr. Michael Lartey for promotion

External Assessor | Appointment and Promotions Board, Sunyani Technical University April 2021
* Promotion assessment

External Examiner for PhD Thesis | Institute of Environmental Studies, University of Ghana 2021
» Examined PhD thesis of Emmanuel Kaboja Magna

External Examiner for MPhil Theses | Department of Chemistry, University of Ghana 2019-2022

* Perpetual Aboabea Anom (2021)
* Emmanuel Yeboah Bonsu (2020)
* Coffie Eric (2019)

* Tofah Kwasi Pascal (2019)

Member | Governing Board, Pharmaceutical Society of Ghana December 2021 - 2023
* Served on the national governing board
Resource Person | "Leading Academic Change Into An Uncertain Covid Era" August 2020

* Delivered presentation on academic leadership during COVID-19 - Christian Service University College
StaffRetreat
Member of Delegation (Speaker) | Third Topical Meeting - United Nations Commission on Narcotic
Drugs, Vienna October 2020
* Represented Ghana at UN Commission on Narcotic Drugs(Virtual)
Member of Delegation (Speaker) | First Topical Meeting - United Nations Commission on Narcotic

Drugs, Vienna June 2020
* Represented Ghana and spoke at UN Commission on Narcotic Drugs(Virtual)

Member | Governing Board, Pharmaceutical Society of Ghana December 2019 - September 2021
» Served on the national governing board

Member | Strategic Committee, Pharmaceutical Society of Ghana December 2019 - September 2021
» Served on strategic planning committee

Resource Person | Leadership Retreat - Christian Service University College August 2020
* Provided leadership training

Member | National Technical Committee on Cosmetics July 2014 to Date
« Serving on national technical committee for cosmetics regulation

Resource Person | Packaging Workshop for Stakeholders - Institute of Packaging Ghana 2014
* Provided expertise on pharmaceutical packaging

Resource Person | Public Education on Rational Drug Use - Hello FM, Kumasi 2013
* Educated the public on rational drug use through radio

Member | Public Education Committee - Pharmaceutical Society of Ghana 2005 - 2009
» Contributed to public education initiatives

Resource Person | ""On the Diary" - Luv FM Kumasi - Public Education on Hepatitis B and C 2008

* Educated the public on hepatitis B and C through radio
Resource Person | Health Talk - " Getting the best out of your medication' - Calvary Charismatic

Centre, Kumasi 2007 - 2008
* Provided health education to the community
Script Writer and Signature Tune Composer | ""Let's talk about drugs'" 2005 - 2006

* Wrote scripts and composed signature tune for national TV programme on drug education-Pharmaceutical
Society of Ghana on Ghana Television

International

Invited Lecturer | China Pharmaceutical University, Nanjing, China 2023 - 2025
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* Annual invited lectureship

Resource Person | 10th Calestous Juma Executive Dialogue, Kumasi, Ghana September 2024
* Provided expertise at international executive dialogue

External Assessor (Senior Lecturer to Professorial Rank) | School of Pharmacy, University of Ibadan,

Nigeria 2024
* Promotion assessment for international university

Resource Person | International Webinar - "Revisiting antacids for gastric acidity" - Shalina

Healthcare Ltd. June 2021
* Presented at international webinar on antacids

Member of Ghanaian Delegation (Speaker) | First Topical Meeting - United Nations Commission on

Narcotic Drugs June 2020
* Represented Ghana and spoke at UN Commission on Narcotic Drugs(Virtual,Vienna)

Member | International Standards Organisation (ISO) Technical Committee on Cosmetics 2015 to Date
* Appointed by Ghana Standards Authority to represent Ghana on ISO technical committee

Editorial Board Member | Herbal Medicine Journal 2016 to Date

» Serving on editorial board of international journal

Planning Committee Member | International Conference on National Sustainable Development

Strategy - IDL, KNUST April 2017
» Committee member for international conference

Reviewer | International Journal of Pharmaceutics 2015
* Peer reviewer for international journal

Reviewer | Pharmaceutical Biology 2015
* Peer reviewer for international journal

Aim-High Associate | University of Greenwich, UK January 2011
» Motivated and helped young adults from disadvantaged backgrounds to access higher education

Founding Father | Medway Ghanaian Association (MGA), UK March 2011

* Co-founded community-based association for Ghanaian students and citizens in the UK
* Upheld Ghanaian culture and promoted physical health of ethnic minority group

International Liaison | Identification of Ghanaian Professors in the Diaspora June 2011
» Liaised for identification of Ghanaian professors abroad

PROFESSIONAL AFFILIATION

ISPOR | International Society for Pharmacoeconomics and Qutcomes Research 2019 to date
* Active member

University Teachers Association of Ghana | UTAG 2003 to date
* Active member

Pharmaceutical Society of Ghana | PSGH 2001 to date
* Active member

Royal Society of Chemistry (UK) | Associate Member 2010 - 2013

* Associate membership

FUNDING, FINANCIAL/RESOURCE MOBILIZATION AND GRANTS
Total Funding Mobilized: $3,687,764.78

Award of Grant For PhD student 2026
* Amount: $75,000
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* Equipment and laboratory instrumentation grant

Co-Investigator: ASPIRE Project | Antimicrobial Stewardship and Infection Prevention in Africa 2024
* Amount: €2.8M ($3,313,386)
» Major international collaborative research project

Research Collaboration Grant | China Pharmaceutical University, Nanjing, China 2023-2025
« Amount: 280,000 rmb ($40,300)
* Research collaboration and exchange funding

Curriculum Development Grant | COA Research and Manufacturing Company Limited 2022
« Amount: GHC 25,000 ($2,283.21)
* Curriculum development for Postgraduate studies in Herbal Medicine

Symposium Sponsorship | Kantanka, Ebenage, COA and Hollard Insurance 2022
* Amount: GHC 19,000 ($1,735.24)
» Symposium on "The State of the Integration of Herbal and Orthodox Medicine in Ghana, the Role of

KNUST"

Facilitator - KN95 Face Mask Donation | Thomas Scientific/Seeding Labs 2021
* Amount: $10,000 (value of donated masks)
» Facilitated donation of KN95 Face Masks to KNUST for COVID-19 protection

RSC Award - Research Exchange | University of Greenwich/KNUST 2020
« Amount: £10,000 ($13,676)
* Royal Society of Chemistry Award for research exchange between University of Greenwich and KNUST

Multi-Grant Awardee - Sth KNUST Research Fund (KReF) | KNUST 2020
* Amount: GHC 30,000 ($2,739.89)
» Competitive internal research grant

Commonwealth Post-Doctoral Fellowship | University of Greenwich, UK 2017-2018
« Amount: £15,000 ($20,513.90)
» Commonwealth Fellowship for post-doctoral research

Instrumental Access Award | Seeding Labs, USA 2017-2018
e Amount: $110,000
* Laboratory equipment and instrumentation grant

Coordinator - Alumni Donation | 1999 Year Group - Faculty of Pharmacy 2018
* Amount: GHC 35,722 ($3,252.43)
* Coordinated donation towards refurbishment of Drug Analysis and Quality Control Lab for Seeding Labs

Instrumental Access equipment

DFID PhD Research Funding | University of Greenwich, UK 2009-2013
« Amount: £62,000 ($84,791)
* Three-year PhD research funding: "Novel formulations for mucosal delivery of protein-based drugs"
* Department for International Development (DFID), UK

Co-Investigator - Safe Water for Good Health Project | Building Stronger Universities 2016
« Amount: $9,923
* Research project on water quality and health

Funding Timeline (Chronological)
* 2026: Instrumental Access Grant - Seeding Labs - $75,000

* 2024: ASPIRE Project (Co-Investigator) - $3,313,386
* 2023-2025: China Pharmaceutical University Collaboration - $40,300
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* 2022: COA Curriculum Development Grant - $2,283.21

* 2022: Symposium Sponsorship - $1,735.24

* 2021: KN95 Face Mask Donation - $10,000

* 2020: RSC Award - University of Greenwich/KNUST Exchange - $13,676
¢ 2020: KNUST Research Fund (KReF) Multi-Grant Award - $2,739.89

* 2017-2018: Commonwealth Post-Doctoral Fellowship - $20,513.90

* 2017-2018: Seeding Labs Instrumental Access Award - $110,000

*2018: 1999 Alumni Year Group Donation (Coordinator) - $3,252.43

* 2016: Building Stronger Universities - Safe Water Project - $9,923

* 2009-2013: DFID PhD Research Funding - $84,791
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REFEREES
Prof. T.C Fleischer

* Professor of Pharmacognosy

* School of Pharmacy

* University of Health and Allied Sciences
* Ho, Ghana

* Email: tcfleischer@uhas.edu.gh

* Tel: +233(0)244597464

Prof. Ellis Owusu Dabo
* Department of Public Health
* School of Public Health
* College of Health Sciences, KNUST
» Kumasi, Ghana
* Email: eowusu-dabo.chs@knust.edu.gh
* Tel: +233(0)201964425

Prof. Joshua Boateng
* Professor in Pharmaceutical Sciences
* School of Science
* University of Greenwich
* Medway Chatham Maritime, Kent, UK
* Email: j.sboateng@gre.ac.uk
* Tel: +44(0)2083318980
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